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Chapter 1  Overview 

Dear Researcher: 

We thank you for your investment in our Thermo Scientific™ MYECL™ Imager. We 
have worked to design a highly functional, yet intuitive, imager that will provide you 
with valuable images and data of high-resolution and quality. 

This manual has been written as a concise guide for the start-up, use and 
customization of your MYECL Imager unit and acquisition software. Detailed sections 
covering the imager, image acquisition, file management, maintenance and 
troubleshooting provide comprehensive information. We encourage you to read the 
entire manual for a full understanding of the imager, but a Quick Start guide is 
provided if you want to begin using your new imager immediately.  

Thermo Scientific products are always at the forefront of scientific instrument 
design, and we strive to design and produce instruments that can help you achieve 
your research goals. Your feedback is a valuable tool that we use for future product 
development, so please contact us if you have any questions, comments or 
suggestions. 

IMPORTANT  Review and implement guidelines for proper set-up before installation. 
Locate the imager away from water, solvents, corrosive materials, strong magnetic 
fields and vibration sources. 

IMPORTANT  The imager weighs 65lbs (29.5kg). Please use two people to lift it by 
grasping the bottom and the handle at the rear of the imager. Using two people, 
place the imager onto the benchtop given proper space, electrical and environmental 
requirements. Remove the outer packaging materials. 

IMPORTANT  Imager use outside of the workflows described in this manual may put 
the operator at risk of dangerous exposure to electrical shock or radiated emissions. 
Do not use this instrument for any purposes or in any configurations not described in 
this manual. 
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 Imager Overview 
 

Included Accessories 

 

 

 

 

 

For technical or service assistance on the MYECL Imager: 

 U.S. Customers: 1-800-874-3723 
 International Customers: 1-815-968-0747 
 European Customers: +49-228-8502820 
 Asia/Pacific Customers: +81-3-5826-1659 

Technical Support email for U.S. and international customers: 
pierce.ts@thermofisher.com 

Technical Support email for European customers: 
perbio.eurotech@thermofisher.com 

Technical Support email for Asia/Pacific customers: 
Info.bid.jp@thermofisher.com 
 
For more information about the Thermo Scientific Protein Biology product line, 
please visit our website: www.thermoscientific.com/pierce 

The MYECL Imager is designed to be a useful tool for the researcher needing intuitive 
equipment and software with fast imaging capabilities.  

Your imager purchase includes the following accessories (each quantity 1): 

Thermo Scientific™ MYImageAnalysis™ Software 
MYECL Imager User Manual CD 
Chemiluminescence exposure screen 
White light conversion screen 
UV exposure screen 
Imaging reference target 
Quick start guide  
USB memory device 
Stylus  
Stylus holder  
Power cord with C13 connector 

Optional items, including additional filters and UV bulbs (365nm), may be added to 
the above list depending on the items ordered with the imager. 

Note  Upon receiving your imager, please verify you have received all of the items 
listed above. Please contact Thermo Scientific Technical Support for assistance.  

mailto:pierce.ts@thermofisher.com
mailto:perbio.eurotech@thermofisher.com
mailto:Info.bid.jp@thermofisher.com
http://www.thermoscientific.com/pierce
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Functionality 

 

 

 

 

          

 

 

Thermo Scientific  
 MYECL Imager 

Acquisition Software 

 

 

 

 

 

 

 

 

 

 

The MYECL Imager provides: 

 UV and white light illumination source for imaging of samples 

 Acquisition of chemiluminescent Western blot and electrophoresis gel images 
with varying resolution (1×1, 2×2, 3×3, 4×4 and 8×8 binning) 

 Low-noise, high-dynamic range CCD camera detection 

 Hardware and software optimized for image acquisition 

 One-touch image acquisition 

 Multiple image acquisition with pre-set and user-defined settings 

  

Each imager arrives loaded with the MYECL Imager Acquisition Software. This 
manual gives detailed information on using all software functions and modes.  

The acquisition software allows you to acquire images using three different modes: 

Chemiluminescence (Chemi)  mode for image acquisition of self-emitting, 
chemiluminescent light  

Ultraviolet (UV)  mode for image acquisition of UV-transmitted light 

Visible (Vis)  mode for image acquisition of reflected and/or transmitted light 
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Thermo Scientific 

MYImageAnalysis 
Software 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The MYImageAnalysis Software is supplied with the MYECL Imager as a vital tool for 
extracting information from your captured images. The analysis software features: 

 Indentify lanes and bands automatically  

 View and compare up to six images simultaneously 

 Open multiple image formats (e.g., .tif, .jpeg, .png, etc.) 

 Export images and data reports directly to Microsoft™ Excel™, Word™ and 
PowerPoint™ software for further analysis and presentations 

 Analyze molecular weight – determine the Rf and molecular weight of protein or 
nucleic acid bands using installed or custom added molecular weight markers 

 Edit digital images – image editing tools include contrast adjustment, image 
rotation, cropping, de-speckling, false color application and text annotation 

 Calculate sample purity automatically based on band and lane intensity 

 Perform lane profile densitometry 

 Quantitate bands or regions relatively or absolutely 

Acquired images are saved and exported as .tif files, which can be directly opened in 
the analysis software. 
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Installation 
Guidelines 

 

       

 

Space Requirements 

 

 

 

 

 

 

 

 
Electrical Requirements 

 

 

 

Chapter 2  Imager 

IMPORTANT Review and implement guidelines for proper set-up before installation. 
Locate the imager away from water, solvents, corrosive materials, strong magnetic 
fields and vibration sources. 

IMPORTANT The imager weighs 65lbs (29.5kg). Use two people to lift it by grasping 
the bottom and the handle at the rear of the imager. Using two people, place the 
imager onto the benchtop given proper space, electrical and environmental 
requirements. Remove the outer and inner packaging materials. 

The imager requires a stable laboratory bench or table capable of supporting 65lbs 
(29.5kg). Provide a minimum clearance of 3 inches (7.62cm) at the rear of the 
imager to allow adequate ventilation for camera cooling and access to the power 
cord and switch. In addition, allow sufficient space to open the front-facing imager 
door to place sample within the imager. Instrument dimensions are listed in                
Table 2-1. 

Table 2-1. Imager dimensions. 
Dimensions Inches Centimeters 
Width 12.25 31.1 

Depth 22 55.9 

Height 21 53.3 

 

A grounded circuit capable of delivering the appropriate current and voltage is 
required for installation. Electrical requirements can be located on the imager label 
on the rear panel of the imager and in Table 2-2. The imager electrical system 
adjusts to the proper voltage for the respective country (Table 2-3). Connect the 
imager power cord to the rear left side panel of the system and plug into a grounded 
power outlet.  
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Environmental 
Requirements 

 
Computer Requirements 

 

 

 

 

 

 

 

 

 

 

Table 2-2. Imager electrical ratings. 
Electrical Parameter Rating 
Supply Voltage (VAC) 120-240 
Frequency (Hz) 50-60 
Power Rating (W) 120 
Fuse (power center) T4AL, 250V, 4A 

 

Table 2-3. Imager electrical requirements for major countries. 
Region Voltage 

(VAC) 
Frequency 

(Hz) 
Amps (A) 

US and Canada 120 60 1.0 
Europe 220 50 0.5 
UK 240 50 0.5 
Japan 100 50 1.2 
China 220 50 0.5 
India 230 50 0.5 
South Korea 220 60 0.5 

 

For optimal performance, maintain a constant laboratory temperature range of 15-
25°C (59-77°F) with relative humidity between 15-70%. To allow adequate camera 
cooling, do not place the imager in direct sunlight. 

The imager is operated by an integrated computer, which is accessed through the 
touchscreen.  

The MYImageAnalysis Software program is included with the imager purchase. To 
run the MYImageAnalysis Software properly, workstations must meet the minimum 
performance requirements listed in Table 2-4.  

Table 2-4. Recommended computer requirements for 
MYImageAnalysis Software. 
Description Recommended 
Operating System Windows 7, Vista*, or XP* 
Processor Pentium* 4 @ 2.4GHz 
Memory (RAM) 512MB 
Hard Drive 2GB 
Screen Resolution 1280 × 1024† 

† Refer to the MYImageAnalysis Software User Manual for more information. 
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Imager Images with 
Feature Locations 

Imager Front View 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-1. Imager front and side views detailing main components. 
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  Imager Front View with 
Sample Door Open 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-2. Imager view with the sample door open and the transilluminator 
extended. 
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Imager Rear View 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 2-3. Rear imager view. 
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Start Up 

 

 

Hard Start Up 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

IMPORTANT  Allow the imager to equilibrate for 20-30 minutes after each initial 
hard power up. This ensures that the camera is optimally cooled before image 
acquisition.  

 

To perform the Hard Start Up procedure: 

1. Turn on the hard power switch located at the bottom of the rear imager panel. 
The hard power switch provides power to all of the imager components.  
 

2. Turn on the soft power switch on the front of the imager. This switch activates 
the internal computer, touchscreen and thermoelectric camera cooler. 
 

3. The computer boots up. 
 

4.  The user is prompted to enter the current date, time and time zone. Upon 
completion, the screen automatically moves to the default Chemi acquire 
screen.  
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Soft Start Up 

 

 

 

 

 

 

Shut Down 

 

 
Soft Shut Down 

 
 

 
 

 
 

 
 
 
 
 

Hard Shut Down 

 

 

 

 

If the imager is powered down by the Soft Shut Down procedure, then a Soft Start 
Up can be done using the front, soft power switch. The soft power switch is the blue 
lighted switch located just above the front door and below the touchscreen. This 
switch allows the user power down the imager computer and touchscreen, while 
maintaining power to the camera cooling unit. This feature allows the user to power 
down the imager, but, once needed, quickly restart the imager without having to 
wait for the camera temperature to re-equilibrate. 

1. Turn on the front soft power switch. The computer restarts and the touchscreen 
initiates with the default Chemi screen. 
 

2. Begin normal operation of the imager. 

Note  For extended periods of inactivity, the imager can be hard powered off; 
however, for typical daily use, optimal camera temperature, and best image quality, 
avoid hard powering on and off the imager. 

The Soft Shut Down procedure uses only the front soft power switch.  

1. Save any current image analyses. 
 

2. Safely remove any USB flash drives. 
 

3. Turn off the soft power switch. 
 

4. The computer and touchscreen shut down and turn off. The fans continue 
running as needed. The camera cooler remains powered and continue to 
maintain the camera at the optimal -25°C. 
    

5. The transilluminator and epi-white lights turn off. 

The Hard Shut Down procedure uses the hard power switch on the rear of the 
imager. This turns off all power to the imager, including the computer and camera 
cooler. 

1. Follow the Soft Shut Down procedure. 
 

2. Turn off the hard power switch at the rear of the imager. 
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USB Features 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The three external USB ports on the right side of the imager can be used for flash 
drives, which can be connected through any of the USB ports for easy file 
management. 

Note  The Export button always exports files to the E:\ drive, which is automatically 
the first additional drive connected to the imager. When connecting an external hard 
drive to the imager, assign the external drive to a letter other than C, D or E. 

 

Figure 2-3. Location of upper USB port. 

 

Figure 2-4. Location of lower USB ports. 
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Imager Settings 

  Tools 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Tools button in the top right corner of the acquisition software screen allows 
access to basic imager settings and functionality.  

1. Select the Tools button to open the Tools screen. 

 

The Tools screen displays the serial number of the system and the current software 
version installed in the system. Large buttons for Date and Time, Printer, Filters, and 
Administrator Settings are displayed on the screen. Select the appropriate button to 
enter setup for each item.  

 

Tools button 
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Date and Time 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To correct the date, time or time zone: 

1. Select the Date and Time button. A Windows clock and calendar is displayed.  

2. Choose the correct settings as needed.  

3. Select the Apply button, followed by the OK button to save the settings. 
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Printer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To select a default printer for imager exporting: 

1. Select the Printer button. A Printers and Other Devices screen is displayed. 

2. Choose the appropriate printer from the listed selections. Plug-and-play printers 
automatically populate the list. Select Add a Printer from the left column if the printer 
is not a local printer or plug-and-play type. A network printer can also be selected as 
a default printer. 

Note  Consult your facility’s IT department for assistance in setting up network 
printers.  
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Filters 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The imager has four default filter positions: 

Position 1: No filter (for use in Chemi applications) 

Position 2: Orange filter (for use in UV and Vis applications) 

Position 3: No filter 

Position 4: No filter 

The imager is supplied with an orange filter in Position 2, but green, red and blue 
filters can also be purchased for additional applications. Install additional filters into 
Positions 3 and 4. Assign filters to the different positions in the Filter Menu 
Selections in the Tools menu.   

1. Select the Filters button. The following menu appears: 

 

2. Positions 2, 3 and 4 use selectable drop-down menus to enable filter 
assignment: Chemi (empty), Orange, Green, Blue and Red. Select the choice for 
each filter position. 
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3. When complete, select the Save button at the bottom of the menu to save the 
changed defaults. 

 

Table 2-5. Imager filter specifications and corresponding dyes. 

Filter Color Wavelength Range 
(nm) 

Compatible Dyes 
and Stains 

Sample Screen 

Blue 445-480 DAPI Clear screen 
AMCA Clear screen 

Green 515-560 SYBR* Green Clear screen 
SYBR Gold Clear screen 

Orange 545-630 Ethidium Bromide  Clear screen 

Hoechst Blue§ Clear screen 

Coomassie Blue White screen† 

Imperial* White screen† 

Red 620-645 SYPRO* Ruby Clear screen 
Deep Purple* Clear screen 

§ With the MYECL Imager, the orange filter is optimal for Hoechst Blue imaging. 

† Coomassie Blue and Thermo Scientific Imperial Stains do not require the orange filter; 
however, these stains require the white light conversion screen. UV and Vis modes use the 
orange filter in Position 2 by default. 
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Administrator Settings 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Selection of Administrator Settings displays the following screen requiring a User 
Name and Password. Only the designated administrator should access this section.  

 

Users do not typically need to access Administrator Settings. Only the facility 
administrator should have access to these functions through password access. The 
default user name and password are myecl and 1234, respectively. To avoid 
improper access, the designated administrator needs to change this username and 
password once the imager is installed. To change the password, select the Change 
User Name/Password button. 
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Set Image Gallery Location 

 

 

 

 

 

 

 

 

 

 

 

 
 

Allow Remote Access 

 

 

 

 

 

 

The Set Image Gallery Location button allows the administrator to set up a default 
pathway for saving acquired images. The imager has a default image gallery 
location, “Computer – Local Disk (D:\) – Gallery_1”. The image gallery location can 
be changed to another folder in a local or network drive. When Set Image Gallery 
Location is selected, the program automatically creates a “Gallery_1” folder if there 
are no previously saved images in the selected folder. 

1. Select the Set Image Gallery Location button. 
 

2. Browse for the appropriate gallery location using the folder menu. 
 

3. Select OK after choosing the appropriate storage location. 

 

 

Remote access for maintenance and troubleshooting is possible with the imager. 
After selecting the Allow Remote Access button, the administrator views the 
following screen:  
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Follow the instructions provided and contact our Technical Support team for 
questions or to troubleshoot the imager. 

U.S. contact: 800-874-3723 

International contact: +1-815-968-0747 

Europe contact: +49-228-8502820 

Asia/Pacific contact: +81-3-5826-1659 

Note  Remote access requires the imager to be connected to a network with internet 
access. Contact your facility’s IT department regarding correct set up and use of 
network connections. 
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Other OS Settings 

 

 

 

 

 

 

 

 

 

 

 
Reset Default Focus Position 

 

 
Update Software  

Change Username and 
Password 

This function allows the administrator to access the Windows Control Panel to 
change system and user configurations as needed.  

Note  Only qualified administrators should have access to this area. Altering 
configurations can cause imager errors. 

 

The default focus position can be reset or changed by selecting the Reset Default 
Focus Position button. The focus position may need resetting if the current default 
focus position does not provide in-focus images. The administrator can control this 
position by going to “Tools” > “Administrator Settings” > “Reset Default Focus 
Position” and using the slider bar to focus in or out to achieve the required 
sharpness in Chemi, UV and Vis modes.  

This function installs and updates the acquisition software when a program update 
becomes available. 

This function allows the administrator to change the username and password for 
accessing the administrator settings. 
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Create Dark and Bias Images 

 
 

 

 

 

 

 

 

 

 

 

 

Dark current is the thermal noise generated from a CCD (charge coupled device). 
This thermal noise is proportional to a power law of CCD temperature. The bias 
noise is introduced as the analog signal is converted to a digital signal. The MYECL 
Imager applies dark and bias noise compensation using dark and bias masters upon 
image acquisition. 

This function allows the administrator to create new dark and bias master files. Dark 
and bias masters need to be updated only when strong CCD noise appears on 
acquired images. It takes ~14 hours to create all of the dark and bias masters in the 
system; therefore, creation of new dark and bias masters is best accomplished by 
beginning the process at the end of the day and allowing the masters to be created 
overnight. 

1. Select the Tools button. 

2. Select the Administrator Settings button. Enter the User Name and Password. 
Select the Login button. 

3. Select the Create Dark and Bias Images button. The following screen is 
displayed: 

 

4. Select Start. To create only dark or only bias masters, choose the corresponding 
check box next to the desired selection. 

Note  Select the Cancel button to return to the Administrator Settings screen. 

5. Place the black sample screen on the transilluminator and close the door. 
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6. Select OK to begin or Cancel to return to the Administrator Settings screen. 

 

7. Select OK. The following screen will appear: 

 

Note  To avoid inaccurate dark and bias master creation, the door must remain 
closed during the entire dark and bias image acquisition process.  

Note  Interruption of dark and bias master creation by opening the door or selecting 
the Stop button stops the process and discards all acquired masters. In this case, 
previous dark and bias masters are used for subsequent image acquisition. 
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Return 

 

 

 

 

 

8. Once the dark and bias image acquisition process is complete, the following 
screen will appear: 

 

9. Select OK to return to the Administrator Settings screen. 
 

Select Return to return to the previous Tools menu. 
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Imager Settings 

 

 

 

 

 

 

Live Camera 

 

          Live Camera in 
Chemi mode 

 

Chapter 3  Image Acquisition 

Upon powering up the imager, the MYECL Imager welcome screen is displayed.  

 

Note  When performing the Hard Start Up procedure, the thermoelectric camera 
cooler is NOT at the ideal temperature of -25°C. After powering up the imager, allow 
10-30 minutes for the camera to cool to the optimal temperature. 

Enabling the Live Camera button displays the streaming image from the camera and 
allows access to Camera Settings (Focus, Aperture, Resolution/Sensitivity, Filter   
and Digital Zoom). Disabling the Live Camera button displays previously acquired 
images. Opening the imager door enables Live Camera and turns on the epi-white 
lights. Refresh rate of live image display depends on the binning setting selected in 
Resolution/Sensitivity (greater resolution requires more time to display). 

Selection of Live Camera in Chemi mode turns on the epi-white lights. ChemiV 
images are captured and saved to the Gallery; however, they are not displayed in the 
image tab if Live Camera is not enabled before image acquisition in Chemi mode. 
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                 Live Camera in 
UV mode 

                Live Camera in 
Vis mode 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Selection of Live Camera in UV mode turns on the UV light. The live image is 
displayed with the exposure time used in the previous image acquisition in UV mode 
unless the user changes the exposure time or changes the mode. 

 
Selection of Live Camera in Vis mode turns on the UV and epi-white lights. The live 
image is displayed with the exposure time used in the previous image acquisition in 
Vis mode unless the user changes the exposure time or changes the mode. 
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    Camera Settings 
Available in Chemi, UV 

and Vis Modes 

 

 

 

 

 

 

 

 

        

 

 

 

 

 

 

 

 

 

 

Note  Camera Settings are only available with the live image display 

Focus  Icon for performing minimal focusing adjustments that may be needed as 
varying object depths change. 

Note  An Imaging Reference Target is supplied with the imager. Use this target in Vis 
mode when performing camera focusing. 

Digital Zoom  Icon for increasing the camera zoom level. Slider bars appear after 
increasing the zoom level to center the image acquisition area. Image acquisition 
with Digital Zoom results in capture of the zoomed image. 

Resolution/Sensitivity  Icon for adjusting the camera image sensor’s degree of 
response to light; the number of camera pixels used to capture an image. To 
enhance detection sensitivity, the pixels, or light capturing units of the CCD chip, can 
be combined or binned. The process of binning bundles multiple pixels, which 
effectively increases the amount of light collected. Figure 3-1illustrates the binning 
process using 7 m pixels as examples for 1×1, 2×2 and 3×3 binning settings. 
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Figure 3-1. The binning process. 

The Resolution/Sensitivity selection allows for choosing among five different 
sensitivities: 1×1 (far left setting), 2×2, 3×3 (middle, default setting), 4×4 and 8×8 
(far right setting) binning. Selection of 1×1 binning provides minimum 
sensitivity/maximum resolution, while selection of 8×8 binning provides maximum 
sensitivity/minimum resolution. Table 3-1 provides multiple specifications related to 
the varied binning sizes. 

Table 3-1. Binning specifications for sensitivity settings. 

Binning Size 
(kb) 

PPI 
(pixels/ 
inch) 

Pixel × Pixel Image size 
(inches × 
inches) 

Image size    
(mm × mm) 

Pixel size      
(µm × µm) 

1 × 1 8197 300 2048 × 2048 6.8 × 6.8 173.4 × 173.4 84.7 × 84.7 

2 × 2 2050 300 1024 × 1024 3.4 × 3.4 86.7 × 86.7 84.7 × 84.7 

3 × 3† 910 300 682 × 682 2.3 × 2.3 57.7 × 57.7 84.7 × 84.7 

4 × 4 513 300 512 × 512 1.7 × 1.7 43.3 × 43.3 84.7 × 84.7 

8 × 8 129 300 256 × 256 0.9 × 0.9 21.7 × 21.7 84.7 × 84.7 

† 3 × 3 binning in 16-bit grayscale .tiff image files are the default settings for the imager. 

 

Reset  Button used to reset all imager settings to their default values. 
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Settings Only Available in 
UV and Vis Modes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Aperture  Slider bar for adjusting the camera lens opening to control sensitivity and 
depth of field. The aperture can be fully closed (far right position) or fully opened (far 
left position) depending on the light sensitivity needed. 

UV Light  Button for turning on/off the transilluminator UV bulbs. 

Filter Wheel Position  Drop-down menu for moving the filter wheel position to switch 
filters. 

Note  Filter Wheel Positions 2-4 can be set for different filter colors by accessing 
Tools > Filters.  
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Chemiluminescence 
(Chemi) Mode 

 

Camera Settings 

 

Interactive Chemi 

 

 

 

 

 

 

 

 

 

 

 

 

Chemiluminescence (Chemi) Mode is the default mode. Chemi mode is used for the 
capture of sample images using sample-emitted light. A visible image of the sample 
is automatically captured in Chemi mode using reflected light (ChemiV image), which 
is useful for imaging colorimetric molecular weight markers. 

Focus, Digital Zoom and Resolution/Sensitivity camera settings are available in 
Chemi mode. 

Interactive Chemi is a patent-pending interactive tool used to evaluate and optimize 
imaging exposure time before acquiring a Western blot image. The Interactive Chemi 
button automatically calculates the exposure time of the Western blot with maximum 
dynamic range and minimal pixel saturation from a short exposure image. The 
feature displays real-time changes of the calculated Western blot image with 
adjusted exposure time and allows further exposure-time refinement through user 
input. 

1. Select the Interactive Chemi button. The imager acquires a 15-second 
exposure. 

 

Note  A Stop button appears over the keypad area once the Interactive Chemi button 
is selected. Image acquisition can be stopped by selecting the Stop button. 
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2. The imager calculates and displays the exposure time with maximum 
dynamic range and minimum pixel saturation. The slider bar location and 
Time Display/Input button correspond to the calculated exposure time. 

Note  Exposure time ranges from 1 second to 99 minutes 99 seconds. If the 
15-second sample image is saturated, then the imager automatically sets 
the calculated exposure time to 5 seconds. 

  

3. Use the exposure time slider bar and updated image preview to obtain the 
desired exposure time. Drag and release the slider bar to update the image 
preview. Alternatively, select the Time Display/Input button to enter a 
custom exposure time that updates the image preview and slider bar 
location. 

 

Note  Once a number is selected, the Enter button is enabled and the 
Cancel button becomes a Clear button. Select Enter or the Time 
Display/Input button to accept the exposure time.  
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4. Select the Reset Calculated Exposure button to return to the imager calculated 
exposure time. 

Note  The Invert button is a useful tool for viewing faint gel bands. This tool inverts 
the standard black background with white highlights to a white background with 
black highlights. The inverted image can be switched back to the standard image by 
again selecting the Invert button. 

Note  The Display Saturation button is automatically selected in Interactive Chemi to 
highlight the image pixels that are considered saturated (a red false-color is 
superimposed on the pixels deemed to be saturated). Adjustment to the saturation 
can be done by adjusting the exposure time with the slider bar or Time Display/Input 
button. Select the Display Saturation button to turn off the false-color imaging. 

5. (Optional) Select the point of interest on the image to display the estimated pixel 
intensity of the corresponding pixel coordinates. The displayed pixel intensity 
(estimated) is updated when the exposure time is further adjusted. 

 

6. Select the Acquire button to capture an image with the indicated exposure time. 

7. Select the Cancel button to return to Chemi mode. 
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Capture Settings 

Single Image Acquisition 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
. 

 

1. Select the Chemi tab on the touchscreen. 
 

2. (Optional) Select the Live Camera button if the live image is not displayed. 
 

3. The epi-white lights and live image display are activated. Open the imager door, 
pull out the transilluminator and install the chemiluminescence exposure screen 
(black) on the transilluminator glass.  
 

4. Insert and center the sample on top of the chemiluminescence exposure screen 
(black) using the live image display for reference. 
 

5. Close the imager door. 
 

6. While viewing the live image, adjust the settings for Focus, Digital Zoom and 
Resolution/Sensitivity in the Camera Settings, if needed. 
 
Note  Camera Settings are available only with the live image display. 
 

7. Select a Pre-set or Custom exposure time. 

Note  ChemiV images are captured and automatically saved to the Gallery; however, 
they are not displayed in the image tab if Live Camera is not enabled before image 
acquisition in Chemi mode. Saved ChemiV images can be displayed in Gallery mode 
along with the Chemi images. 
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Pre-set Exposure Time 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Select one of the pre-set exposure time buttons on the touchscreen keypad. The 
imager takes an image as soon as the exposure time button is selected. 
 

 
 

2. Captured images are displayed on the screen and automatically stored in the 
Gallery for further review and selection. 
 

Note  A Stop button appears over the keypad area once an exposure time button is 
selected. Image acquisition can be stopped by selecting the Stop button.  

Note  Up to six recent images can be displayed on the touchscreen. 
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Custom Exposure Time 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Select the Custom exposure button using the touchscreen keypad. 
 

2. Enter the desired time in milliseconds (ms), seconds (s) or minutes (m) using the 
touchscreen keypad numbers. The m : s box is used to input seconds and/or 
minutes and is active by default (box is gray in color). For a custom exposure 
time of <1 second, select the ms box to input milliseconds. The shortest 
exposure time that can be entered is 10 milliseconds; selecting “1” from the 
keypad appears as “10” in the ms box. 

 

 

 
 

3. Once a number is selected, the lower Cancel button becomes a Clear button. 
Use this to remove entered numbers.  

Note  Selecting the Cancel button returns the custom exposure time keypad to 
the pre-set exposure time keypad. 
 

4. Select the Acquire button to capture the image.  
 

5. The image displays in a tab on the touchscreen and is saved to the Gallery. 
 

Note  A Stop button appears over the keypad once the Acquire button is selected. 
Image acquisition can be stopped by selecting the Stop button. 

Note  Up to six recent images can be displayed on the touchscreen. 
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Multiple Image Acquisition 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Select the Chemi tab. 
 

2. (Optional) Select the Live Camera button if the live image is not displayed. 
 

3. The epi-white lights and live image display are activated. Open the imager door, 
pull out the transilluminator and install the chemiluminescence exposure screen 
(black) on the transilluminator glass.  
 

4. Insert and center the sample on top of the chemiluminescence exposure screen 
(black) using the live image display for reference. 
 

5. Once the sample is centered, close the imager door. 
 

6. While viewing the live image, adjust the settings for Focus, Digital Zoom and 
Resolution/Sensitivity in the Camera Settings menu, if needed. 
 
Note  Camera Settings are available only with the live image display. 
 

7. Select a Pre-set or User-defined Multiple Exposure Time. 
 
Note  A Stop button appears over the keypad once the Acquire button is 
selected. Image acquisition can be stopped by selecting the Stop button. 
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Pre-set Multiple Exposure 
Settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The five pre-set multiple exposure settings allow you to select a time series of 
exposures.  

 

1. Select the Multi button from the touchscreen number keypad. 
 

2. Select one of the Pre-set # option buttons with an appropriate time series of 
exposures.  
 

3. The images are automatically acquired. 
 

4. Captured images are displayed on the screen and stored in the Gallery for 
further viewing and selection. 
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User-defined Multiple Exposure 
Settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The User-defined Multiple Exposure settings allow the user to set custom times in 
situations where the pre-set exposure times do not meet your needs. 

 

1. Select the Multi button from the touchscreen number keypad. 
 

2. To create or edit the user-defined exposure time settings, select the Edit button 
to highlight the five Exposure fields. 
 

3. Choose one of the User # option buttons to highlight the set of cells for user 
input. 
 

4. Using the pre-set or custom exposure time keypad, input the desired time into 
each cell. The highlighted cell moves to the right as each time is input. 
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5. The Total time is calculated and displayed as each new time is input into a cell. 
 

6. After all desired exposure times are entered, select the Save button (former Edit 
button) in the top right corner of the table. This saves the User # time settings 
for further uses. All five User # time settings are entered and saved the same 
way. 
 

7. Select the User # button to automatically capture the images. 
 

8. Captured images are displayed on the touchscreen and stored in the Gallery for 
further viewing and selection. 
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Image Tools 

ChemiV Overlay 

 

 

 

 

 

 

 

 

 

Display Saturation 

 

 

 

 

 

 

 

 

 

 

 

Note  The Image Tools only function while viewing or printing the image. ChemiV 
Overlay, Display Saturation, Invert, Auto Contrast and Adjust Image adjustments are 
NOT saved with the image file. 

After capturing an image in Chemi mode, the ChemiV Overlay button can be 
selected to superimpose the corresponding ChemiV image on top of the Chemi 
image. Image adjustment can be applied to the overlaid image, and the intensity 
display from the original Chemi image can be displayed on the overlaid image. The 
ChemiV Overlay button is enabled only when user is viewing a Chemi image. 

 

       Original Chemi Image                      With ChemiV Overlay 

In Chemi mode, after capturing an image, the Display Saturation button can be 
selected to highlight image areas that are considered to be saturated. A red false-
color is superimposed on the areas deemed to be saturated. Adjustment to the 
saturation can be done by adjusting the exposure time for subsequent images. 
Shorter exposure times reduce the light exposure/saturation. 

1. After capture of an image, select the Display Saturation button under the time 
keypad. 
 

2. The screen displays the saturated pixels on the image with a red false-color. 
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Invert Image 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

If the image appears to be over- or under-saturated, the image exposure time may 
need to be increased or decreased to acquire a properly saturated image. Exposure 
time can be adjusted for subsequent image capture by using the number keypad. 

3. The Display Saturation button can be selected again to turn off the false-color 
imaging. 
 
Note  The Display Saturation button is disabled when the Auto Contrast or 
Adjust Image functions are enabled. 

 

The Invert button is a useful tool for viewing faint gel bands. This tool inverts the 
standard black background with white highlights to a white background with black 
highlights or vice versa. 

 
 

Original Chemi Image 

 
 

Inverted Chemi Image 
 

1. In the active live image or acquired image, select the Invert button under the 
time keypad. 
 

2. The inverted image can be reverted to the standard image by again selecting 
the Invert button. 
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 Auto Contrast 

 

 

 

 

Adjust Image 

 

 

 

 

 

 

 

 

 

 

 

Selecting the Auto Contrast button increases the contrast between the signal and 
the background to increase visibility. This adjustment can only be used for viewing or 
printing the image. The contrast adjustment is NOT saved with the image file.  

Note    Auto Contrast is disengaged when the Adjust Image button is selected. 

                
       Original Chemi Image                          Auto Contrast Adjusted Chemi Image 

 

Select the Adjust Image button to modify the Black, White and Gamma levels of the 
image to increase sample visibility. This adjustment is only used for viewing or 
printing the image. Image adjustments are NOT saved with the image file. 

 

Select the Reset button to restore Black, White and Gamma to original levels. Select 
the Close button to return to the previous screen. 

Note  Adjust Image is disengaged when the Auto Contrast button is selected. 
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Intensity Display 

 

 

 

 

 

 
Zoom 

 

 
File Menu 

 

 

 

 

 

 

Select a point of interest on the acquired image to view the Intensity Display 
containing the pixel intensity and pixel coordinates of the corresponding region. 
When multiple images of the same sample are acquired and displayed on the 
screen, the pixel intensities of the same location can be viewed and compared 
between multiple images by selecting the corresponding image tabs. 

 

 

A Zoom slider bar is located under acquired images for zooming in and out on the 
image. The zoom level (percentage) is displayed next to the slider bar. 

 

 

 

 

The File Menu consists of buttons for Image Info, Export, Print and Delete. 
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Image Info 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Information for each captured image is stored within the individual .xml file. 

With the captured image displayed, select the Image Info button. A box appears with 
all of the relevant image information for that image. Beneath the box is a keyboard 
for inputting personal data into the open fields. Only the fields for File name, User, 
Project and Notes can be modified. 

Note  After each image capture, the imager will assign a default name to the image 
file. This image file name can be changed within the Acquisition Information screen. 

 

File name  Image title (imager-generated or user-defined) 

User  Person using the MYECL Imager (user-defined) 

Project  Name of project (user-defined) 

Notes  Relevant notes pertaining to image or experiment (user-defined) 

Exposure time  Chosen exposure time for image 
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Export 

 

 
Print 

 
Delete 

 

 

 

 

 

 

 

 

Mode  Single, multiple, custom, UV or Vis 

Acquisition time  Time of day image was taken 

Acquisition date  Date image was taken 

Sensitivity/Resolution  Binning used for image acquisition 

Select Export to save the highlighted image to a USB flash drive. External flash drives 
can access the imager through three different ports on the right side of the imager. 

Note Users may need to momentarily wait for the imager to detect the external drive 
once it is connected to the USB port. The selected image is exported only to the first 
USB flash drive if there are more than two drives connected to the imager. 

The Print button allows the highlighted image to be printed to a selected external 
printer. A Print Preview window appears before printing begins. 

The Delete button permanently deletes the highlighted image. 
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Ultraviolet (UV) Mode 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Camera Settings 

 

Capture Settings 

Image Acquisition 

Ultraviolet (UV) mode is used for the capture of images using transmitted UV light. 

CAUTION  UV mode uses the UV light in the transilluminator. Long-term exposure to 
UV light can be harmful. Use the appropriate eye and skin personal protective 
equipment (PPE) if there is any chance of exposure to the UV light. 

Note  The transilluminator UV light is initially on for 5 minutes. User input is 
requested for further use of the UV light. If the “Keep UV on” button is not selected, 
the UV light automatically turns off. 

 If the UV light is needed after opening the imager door, the white door peg can be 
pulled out to turn on the UV bulbs. Appropriate PPE must be worn if performing this 
operation. The white door peg returns to a normal position once the door is fully 
closed. 

 

Extended “UV on” position 

 

Retracted “UV off” position 

Note  The live image is displayed with the exposure time used in the previous image 
acquisition in UV mode unless the user changes the exposure time or changes the 
mode. 

UV mode uses the same functional Camera Settings as the Chemi mode, but adds 
the camera setting functions for Aperture, UV light and Filter wheel position. 

1. Select the UV tab on the touchscreen. 
 

2. (Optional) Select the Live Camera button if the live image is not displayed. 
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Pre-set Exposure Time 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Open the imager door and confirm that the UV light is off. The epi-white lights 
are activated once the door is opened. Pull out the transilluminator and place 
the UV exposure screen (clear) on top of the transilluminator. 
 

4. Insert and center the sample on top of the UV exposure screen (clear) using the 
live image display for reference. Once the sample is centered, close the imager 
door. 
 

5. While viewing the live image, adjust the necessary settings for Focus, Digital 
Zoom, Sensitivity/Resolution, Filter and Aperture to produce the desired image. 
 
Note  Camera Settings are only available with the live image display. 
 
 

1. (Optional) Select the Live Camera button if the live image is not displayed. 
 

2. Select one of the pre-set exposure time buttons using the touchscreen keypad.  
 

3. The live image with the new exposure time is displayed. If needed, modify the 
exposure time using the pre-set exposure time buttons.  

  

4. Select the Acquire button to acquire an image.  
 

5. Captured images are displayed on the screen and automatically stored in the 
Gallery for further viewing and selection. 
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Custom Exposure Time 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Select the Custom exposure time button using the touchscreen keypad. 
 

2. Enter the desired time in milliseconds (ms), seconds (s) or minutes (m) using the 
touchscreen keypad numbers. The m : s box is used to input seconds and/or 
minutes and is active by default (box is gray in color). For a custom exposure 
time of <1 second, select the ms box to input milliseconds. The shortest 
exposure time that can be entered is 10 milliseconds; selecting “1” from the 
keypad appears as “10” in the ms box.   
 

 

3. Select the Acquire button to acquire an image. 
 

4. Captured images are displayed on the screen and automatically stored in the 
Gallery for further viewing and selection. 
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Stop Image Acquisition 

 

 

Image Tools 

 
Display Saturation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Upon selecting the Acquire button, a Stop window appears over the keypad. 
Selecting the Stop button stops the current image acquisition exposure and return 
the screen to the current session exposure settings. 

Note  The Image Tools only function while viewing or printing the image. Display 
Saturation, Invert, Auto Contrast and Adjust image adjustments are NOT saved with 
the image file. 

In UV mode, while viewing the live image or after capturing an image, the Display 
Saturation button can be selected to highlight the image pixels that are considered 
to be saturated. A red false-color is superimposed on the pixels deemed to be 
saturated. Adjustment to the saturation can be done by adjusting the Aperture 
and/or exposure time for subsequent images. Shorter exposure times reduce the 
light exposure/saturation. 

1. While viewing the live image display, select the Display Saturation button under 
the time keypad. 
 

2. The screen displays the saturated areas of the image with a red false-color. 
 

3. While viewing the live image display, in Camera Settings, use the Aperture slider 
bar to adjust the saturation by opening (moving slider to left) or closing (moving 
slider to right) the aperture. Opening the aperture increases image brightness 
and saturation. Closing the aperture decreases image brightness and saturation. 
 

4. If required, the image exposure time may need to be increased or decreased to 
display a properly saturated live image. Exposure time can be adjusted before 
image capture by using the number keypad.   
 

5. Select the Display Saturation button again to turn off the false-color imaging. 
 
Note  The Display Saturation button is disabled when the Auto Contrast or 
Adjust Image functions are enabled. 
 

6. Proceed with the steps for acquiring an image. 
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Invert Image 

 

 

 

 

 

 

 

 

 

 

 

 

 

Auto Contrast 

 

 

 

Adjust Image 

 

 

 

 

 

The Invert button is a useful tool for viewing faint gel bands. This tool inverts the 
standard black background with white highlights to a white background with black 
highlights. 

 

 
 

Original UV Image 

 

 
 

Inverted UV Image 
 

1. In the active live image, select the Invert button from under the time keypad. 
 

2. The inverted image can be switched back to the standard image by again 
selecting the Invert button. 

Selecting the Auto Contrast button increases the contrast between the signal and 
the background to increase visibility. This adjustment can be used only for viewing or 
printing of the image. The contrast adjustment is NOT saved with the image file.  

Note  Auto Contrast is disengaged when the Adjust Image button is selected. 

Select the Adjust Image button to modify the Black, White and Gamma levels of the 
image to increase sample visibility. This adjustment is only used for viewing or 
printing the image. Image adjustments are NOT saved with the image file. 

Select the Reset button to restore Black, White and Gamma to original levels. Select 
the Close button to return to the previous screen. 

Note  Adjust Image is disengaged when the Auto Contrast button is selected. 
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Intensity Display 

 

 

 

Zoom 

 

File Menu 

 

 

 

 

Image Info 

 

Export 

 

 
Print 

 
Delete 

 

Select a point of interest on the acquired image to view the Intensity Display 
containing the pixel intensity and pixel coordinates of the corresponding region. 
When multiple images of the same sample are acquired and displayed on the 
screen, the pixel intensities of the same location can be viewed and compared 
between multiple images by selecting the corresponding image tabs. 

A Zoom slider bar is located under acquired images for zooming in and out on the 
image. The zoom level (percentage) is displayed next to the slider bar. 

The File Menu consists of buttons for Image Info, Export, Print and Delete. 

 

Image Info can be selected for any captured image. This lists the acquisition 
information for the highlighted image. 

Select Export to save the highlighted image to a USB flash drive. External flash drives 
can access the imager through three different ports on the right side of the imager. 

Note  Users may need to momentarily wait for the imager to detect the external drive 
once it is connected to the USB port. The selected image is exported only to the first 
USB flash drive if there are more than two drives connected to the imager. 

The Print button allows the highlighted image to be printed to a selected external 
printer. A Print Preview window appears before printing begins. 

The Delete button permanently deletes the highlighted image. 
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Visible (Vis) Mode 

 

 

 

 

 

Camera Settings 

 
                    Image Acquisition –             

Transmitted Light 

 

 

 

 

 

 

 

               

Visible (Vis) mode is used for the capture of gel images using reflected and/or 
transmitted light. 

CAUTION  Vis mode uses the UV lights from the transilluminator. Long-term 
exposure to UV light can be harmful. Use the appropriate eye and skin PPE if there is 
any chance of exposure to the UV light. 

Note  The transilluminator UV light is initially on for 5 minutes. User input is 
requested for further use of the UV light. If the “Keep UV on” button is not selected, 
then the UV light will automatically turns off. 

Note  The live image is displayed with the exposure time used in the previous image 
acquisition in Vis mode unless the user changes the exposure time or changes the 
mode. 

Vis mode uses the same functional Camera Settings as the UV mode. 

1. Select the Vis tab on the touchscreen. Changing to Vis mode automatically turns 
on the UV lights within the transilluminator and the epi-white lights. 
 

2. (Optional) Select the Live Camera button and enable the UV button if the live 
image is not displayed and the transmitted light is off. 
 

3. Open the imager door, confirm the UV light is off, pull out the transilluminator 
and install the white light conversion screen on top of the transilluminator.  
 

4. Insert and center the sample on top of the white light conversion screen using 
the live image display for reference. 
 

5. Once the sample is centered, close the imager door. The UV light turns on and 
shows as visible light transmitting through the white light conversion screen. 
 

6. While viewing the live image, adjust the necessary settings for Focus, Digital 
Zoom, Sensitivity/Resolution, Filter and Aperture to produce the desired image. 

7. Select a Pre-set or Custom exposure time. 
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    Image Acquisition – 
Reflected Light 

 

 

 

 

 

 

 

 

 

 

 

 

Pre-set Exposure Time 

 

 

 

 

 

 

 

 

 

1. Select the Vis tab on the touchscreen. Changing to Vis mode automatically turns 
on the UV lights within the transilluminator and the epi-white lights. 
 

2. (Optional) Select the Live Camera button and enable the UV button if the live 
image is not displayed. 
 

3. Open the imager door, confirm that the UV light is off, and install the white light 
conversion screen on top of the transilluminator glass.  
 

4. Insert and center the sample on top of the white light conversion screen using 
the live image display for reference. 
 

5. Once the sample is centered, close the imager door. The UV light turns on. 
 

6. Select the UV light button on the right side of the screen to switch OFF the UV 
light. This produces only reflected light. 
 

7. While viewing the live image display, adjust the Camera Settings for Focus, 
Digital Zoom, Resolution/Sensitivity, Filter and Aperture to produce the desired 
image, if needed. 
 

8. Select a Pre-set or Custom exposure time. 

1. Select one of the Pre-set exposure time buttons using the keypad.   

  

2. Select the Acquire button to capture an image.   
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Custom Exposure Time 

 

 

 

 

 

 

 

 

 

 

 

 

 
Image Tools 

 

3. Captured images are displayed on the screen and automatically stored in the 
Gallery for further viewing and selection. 
 

Note  A Stop button appears over the keypad once the Acquire button is 
selected. Image acquisition can be stopped by selecting the Stop button. 

 

1. Select the Custom exposure button using the keypad. 
 

2. Enter the desired time using the keypad numbers. The m : s box is used to input 
seconds and/or minutes and is active by default (box is gray in color). For a 
custom exposure time of <1 second, select the ms box to input milliseconds. 
The shortest exposure time that can be entered is 10 milliseconds; this appears 
as “10” in the ms box.  

 

3. Once a value is entered into the Custom time field, the Acquire button will 
become active. Select the Acquire button to capture an image. 
 

4. Captured images are displayed on the screen and automatically stored in the 
Gallery for further viewing and selection. 
 
Note  A Stop button appears over the keypad once the Acquire button is 
touched. Image acquisition can be stopped by touching the Stop button. 

Note  The Image Tools only function while viewing or printing the image. Display 
Saturation, Invert , Auto Contrast and Adjust Image adjustments are NOT saved with 
the image file. 
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Display Saturation 
 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 
Invert Image 

 

 

 

 

 

In Vis mode, while viewing the live image or after capturing an image, the Display 
Saturation button can be selected to highlight live and captured pixels that are 
considered to be saturated. A red false-color is superimposed on the pixels deemed 
to be saturated. Adjustment to the saturation can be done by adjusting the Aperture 
and/or exposure time for subsequent images. Shorter exposure times reduce the 
light exposure/saturation. 

1. While viewing the live image display, select the Display Saturation button under 
the time keypad. 
 

2. The screen displays the saturated areas of the image with a red false-color. 
 

3. Using the Aperture slider bar in Camera Settings, adjust the saturation by 
opening (moving slider to left) or closing (moving slider to right) the aperture. 
Opening the aperture increases image brightness and saturation. Closing the 
aperture decreases image brightness and saturation. 
 

4. If required, the image exposure time may need to be increased or decreased to 
display a properly saturated live image. Exposure time can be adjusted before 
image capture by using the number keypad.   
 

5. Select the Display Saturation button again to turn off the false-color imaging. 
 
Note  The Display Saturation button is disabled when the Auto Contrast or 
Adjust Image functions are enabled. 
 

6. Proceed with the steps for acquiring an image. 

The Invert button is a useful tool for viewing faint gel bands. This tool inverts the 
standard white background with black highlights to a black background with white 
highlights in Vis mode. 

 

 
 

Original Vis Image 

 

 
 

Inverted Vis Image 
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Auto Contrast 

 

 

Adjust Image 

 

 

 

Intensity Display 

 
Zoom 

 

File Menu 

 

Image Info 

Export     

Selecting the Auto Contrast button increases the contrast between most bands and 
the background to increase visibility. This adjustment can be used only for 
touchscreen viewing or printing of the image. The contrast adjustment is not saved 
with the image file.  

Note  Auto Contrast is disengaged when the Adjust Image button is selected. 

Select the Adjust Image button to modify the Black, White and Gamma levels of the 
image to increase sample visibility. This adjustment is only used for viewing or 
printing the image. Image adjustments are NOT saved with the image file. 

Select the Reset button to restore Black, White and Gamma to original levels. Select 
the Close button to return to the previous screen. 

Note  Adjust Image is disengaged when the Auto Contrast button is selected. 

Select a point of interest on the acquired image to view the Intensity Display 
containing the pixel intensity and pixel coordinates of the corresponding region. 
When multiple images of the same sample are acquired and displayed on the 
screen, the pixel intensities of the same location can be viewed and compared 
between multiple images by selecting the corresponding image tabs. 

A Zoom slider bar is located under acquired images for zooming in and out on 
images. The zoom level (percentage) is displayed next to the slider bar. 

The File Menu consists of buttons for Image Info, Export, Print and Delete. 

 

Image Info can be selected for any captured image. This lists the acquisition 
information for the highlighted image. 

Select Export to save highlighted images to a USB flash drive. External flash drives 
can access the imager through three different ports on the right side of the imager.  
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Print 

Delete 

Image Gallery 

Acquisition Information 

  

 

 

 

 

 

 

 

 

 

 

 

Note  Users may need to momentarily wait for the imager to detect the external drive 
once it is connected to the USB port. The selected image is exported only to the first 
USB flash drive if there are more than two drives connected to the imager. 

 

The Print button allows the highlighted image to be printed to a selected external 
printer. A Print Preview window will appear before printing begins.  

The Delete button permanently deletes the highlighted image. 

 

The image gallery allows the user to view and open previously captured images.  

Information for each captured image is displayed under the Browse button. 

When an image is selected in the Gallery screen, File Name, User, Project, Notes, 
Exposure, Date/Time, Resolution, Filter, and Aperture information is populated in the 
Acquisition Information table. 

 

File Name Image title (imager-generated or user-defined) 

User  Person using the MYECL Imager (user-defined) 

Project  Name of project (user-defined) 

Notes  Relevant notes pertaining to image or experiment (user-defined) 



58      MYECL Imager User Manual                Thermo Fisher Scientific 

 

 

 

 

 

 

 

 

Image Viewing 

 

 

 

 

 

 

 

Thumbnail 

 

 

 

 

 

 

 

 

Exposure Chosen exposure time for image 

Date/Time Date and Time image was taken 

Resolution Binning used for image acquisition (1x1=highest resolution, 
8x8=lowest resolution 

Temperature CCD Temperature when image was taken 

Filter  Emission Filter used for image acquisition 

Aperture Aperture change applied when image was taken 

 

1. Select the Gallery tab at the top of the touchscreen. 
 

2. Click on the Browse button to open the gallery. 

 

Thumbnail displays previously captured images. Images are separated into sections 
of days, weeks, months and years. You can use the two right middle arrow buttons 
or the vertical scrollbar to move and view between the sections. If the current gallery 
contains images from more than 40 image acquisitions, the program automatically 
creates a new gallery folder and move to the new gallery. Other galleries can be 
accessed using the up and down Gallery arrow buttons.  
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File List 

 

 

 

 

 

 

 

 

 

 

Search 

 

Choose an image or series of images (up to six images including ChemiV image) by 
selecting the images on the touchscreen. Selected images are highlighted in blue. 
Double-tap on an image or select the Back to Gallery button to return to the main 
image gallery screen.  

Note  Before selecting an image, users can choose to view only the Chemi image or 
both the Chemi and ChemiV images of the same sample by selecting the Open 
ChemiV Image button at the bottom right of the Gallery screen. This function is 
useful for establishing band locations in a Chemi image against known protein 
weight markers in a ChemiV image. 

Note  Select one ChemiM image to open all of the images associated with that 
specific multiple exposure. Up to six images, including ChemiV images, can be 
selected and displayed at one time. 

The File List button displays image information in a list format for ease of searching 
and sorting. The list is sortable in eight different fields by selecting the appropriate 
column heading: File Name, Date, Notes, Mode, Exposure, Project, User and 
Resolution. 

 

The Search tab allows you to search through the full gallery. Images can be 
searched by File Name, Date, Notes, Project or User by entering the needed 
information. The search results are displayed in the Search Result window; the 
results listings are sortable by field. 
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Search Results 

File Manager 

 

 

Copy 

 

 

 

 

 

 

Delete 

 

 

 

 

 

The Search Results button allows for viewing results from the previous search. 
Results listings are sortable by field. 

The File Manager button allows for selection of multiple image files for copying, 
deleting, exporting and editing image information. Images selected in File Manager 
are highlighted in a light green color. The File Manager button can be selected from 
the Thumbnail, File List or Search Results screens. 

Note  File Manager in Search Results contains a Select All/Unselect All button in 
place of an Unselect button.  

The Copy button allows users to copy the selected images from one or more gallery 
folders to the desired location. 

 

 

The Delete button allows users to delete the selected images from one or more 
gallery folders. 
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Export 

 

 

 

 

 

 

 

 

 
 

Edit Info 

 
Unselect 

 
Exit File Manager 

 

 

 

 

 

The Export button allows users to copy the selected images to the first USB flash 
drive plugged into the imager. 

 

 

The Edit Info button allows users to create or change the User/Project/Notes fields of 
the acquisition information for the selected images. File names cannot be changed 
using Edit Info from File Manager. 

The Unselect button removes all of the selections in the File Manager. 

Selecting the Exit File Manager button returns to the previous Gallery mode screen. 
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Cleaning the Imager 
and Sample Screens 

LCD Touchscreen 

 

Cleaning the Touchscreen 

 

 

Use of the Stylus 

 

 

 

 

 

Chapter 4  Maintenance 

IMPORTANT  When using any cleaning products with the imager, consult the 
appropriate material safety data sheet (MSDS) to confirm compatibility with the 
imager and proper usage of the cleaning product. 

Spray a soft cloth or paper towel with cleaning solution (e.g., general purpose 
cleaner, isopropanol or 70% ethanol). Wipe the surface of the transilluminator, the 
sample screens and the imager’s exterior housing.  

Use a pre-moistened LCD screen cleaning tissue to clean the surface of the 
touchscreen.  

IMPORTANT  Use of ammonia-based cleaners to clean the touchscreen is NOT 
recommended. Do not spray cleaner directly onto the LCD screen. 

IMPORTANT  Do not press hard while cleaning the screen. Do not leave excess 
cleaning solution on the LCD screen as this may cause long-term damage. 

The stylus is recommended for interacting with the touchscreen. Use the tip of the 
stylus to tap the touchscreen for selection of menus, icons, and buttons.   

Note  Fingertips can be used for interaction with the touchscreen; however, the 
stylus is easier to use with gloved hands and prevents fingerprints on the screen. 
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UV Transilluminator 

 

Band Excision 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAUTION  The UV transilluminator contains UV bulbs. Long-term exposure to UV 
light can be harmful. Use the appropriate eye and skin personal protective 
equipment (PPE) if there is any chance of exposure to the UV light.  

1. Wearing UV-protective eyewear and clothing, open the imager door and slide 
out the transilluminator. 
 

2. Place the UV exposure screen (clear) on the transilluminator and place the gel 
sample on top of the screen. 
 
IMPORTANT  Use of the UV exposure screen (clear) protects the transilluminator 
from nicks and scratches as a result of excision. 
 

3. In UV mode, select the UV button. A message appears asking if the user wants 
to turn on the UV light with the door open. Select Yes.  
 

4. The software then displays a warning message requiring the appropriate PPE 
and asks the user to pull out the white door peg. 

 

Extended “UV on” position 

 

Retracted “UV off” position 

 

5. Excise the appropriate bands from the gel sample. 

Note  As a safety precaution, the UV light automatically turns off after five minutes. 
With 30 seconds remaining, a message appears on the touchscreen indicating that 
the UV light is turned off unless the “Keep UV on” button is selected. 
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Cleaning the Transilluminator 

 
 

         Replacement of 
Transilluminator Bulbs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. When finished, turn off the UV light by pushing in the white door peg. Push the 
transilluminator back into the imager. Alternatively, push the transilluminator back 
into the imager and close the door, which automatically pushes the white door peg 
back into place. 

Ensure the transilluminator surface is cool. Saturate a clean soft cloth or paper towel 
with cleaning solution (e.g., general purpose cleaner, isopropanol or 70% ethanol). 
Wipe the surface of the transilluminator.  

Note  To ensure uniform illumination, replace all six UV transilluminator bulbs, even 
if only one bulb fails. 

1. Shut down the imager and unplug the power cord. 
 

2. Open the imager door and completely slide out the transilluminator. Ensure the 
transilluminator is cool to touch. 
 

3. Loosen the four thumbscrews on the transilluminator coverplate. 
 

4. Lift the coverplate to expose the bulbs. Use caution to avoid damaging the 
electrical cord. 
 

5. Remove the transilluminator bulbs by rotating ~90° counterclockwise until the 
pins align with the bulb socket. A click is heard when the bulb pins are aligned. 
Lift the bulb up and out of the socket.  
 

6. Insert the new transilluminator bulbs by sliding pins into the bulb socket and 
rotating ~90° clockwise. A click will be heard when the bulb pins are set. 
 

7. Repeat Steps 5 and 6 for the remaining five bulbs. 
 

8. Replace all necessary components of the transilluminator and avoid damaging 
the electrical cord. Replace and hand tighten the four thumbscrews. 
 

9. Push the transilluminator back into the imager. 
 

10. Plug the imager power cord back in and turn the system power on. 
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Emission Filters 

 
 

 
Changing Filters 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A variety of emission filters can be used in the imager. The appropriate filter choice 
is dependent on the emission wavelength of the sample. Consult Table 2-5 in 
Chapter 2 to confirm the filter choice is appropriate for the application. 

The filter wheel allows for easy installation and removal by using threaded filters. 
The filters are fragile, so use caution when handling and installing or removing.  

IMPORTANT  When installing filters, ensure that the filter threads are correctly 
aligned with the filter wheel threads. Forcing a filter to screw in can result in cross 
threading and damage to the filter wheel. 

1. Turn off the system power. 
 

2. Open the imager door and locate the filter wheel at the rear of the cabinet. Each 
filter position is labeled with a red position number.  
 
Position 1  Permanently empty for chemiluminescent imaging 
Position 2  Orange filter (default filter supplied with the imager) 
Position 3  Open for additional filter 
Position 4  Open for additional filter 
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3. To install an emission filter, insert the threaded side of the filter into an open 
port on the filter wheel. Turn clockwise to screw the filter in place until hand 
tight.  
 

4. To remove an emission filter, grasp the outer edge of the filter housing and turn 
counterclockwise to unscrew and remove. 
 

5. When filter installation/removal is complete, turn the system power on. 
 

6. Update the filter settings in the Tools menu. See Chapter 2: Imager for 
directions on changing the filter settings.  
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Appendix A   

Technical Specifications 

Imager Parameter Specification 

Power Maximum 120W 

Frequency Range 50-60Hz 

AC Voltage 100-240V 

Current 1.2A maximum (dependent on supply voltage) 

Fuse T4AL, 250V, 4A fuse 

Dimensions 21 inches H × 12.25 inches W × 22 inches D               
(53.3cm H × 31.1cm W × 55.9cm D) 

Weight 65lbs (29.5kg) 

Wavelength Range Specific wavelengths between 370-700nm 

Camera High-resolution, thermoelectrically regulated at -25°C,          
4.2MP digital camera with 16-bit dynamic range  

Lens 50mm, f/0.95 aperture 

Filter Wheel 4 filter positions, motorized 

Touchscreen 10.4 inch LCD screen 

Light Source 306nm trans-UV, epi-white 

Manufacturer Thermo Fisher Scientific                                                                                                                                               
3747 N Meridian Rd                                                                      
Rockford IL  61105-0117                                                       
USA                                                           
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Appendix B   

Accessories 

Product 
No. 

Product Name Package 
Size 

62237† MYImageAnalysis Software 1 CD 

62238† Orange Filter 1 filter 

62239 Green Filter 1 filter 

62240 Red Filter 1 filter 

62241 Blue Filter 1 filter 

62242† Chemiluminescence Exposure Screen 1 screen 

62243† White Light Conversion Screen 1 screen 

62244† UV Exposure Screen 1 screen 

62255 Transilluminator Bulb, 365nm 1 bulb 

62258† Transilluminator Bulb, 306nm 1 bulb 

62261† Touchscreen Stylus and Holder 1 package 

62267† Imaging Reference Target 1 package 

EW84857 One Year Extended Warranty  

84858† Power Cord/C13 Connector,  North America 1 cord 

84859† Power Cord/C13 Connector, Continental Europe 1 cord 

84860† Power Cord/C13 Connector, United Kingdom/Ireland 1 cord 

† Replacement part for accessory supplied with the MYECL Imager. 
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Appendix C   

Related Thermo Scientific Products 

Product No. Product Name 

34087 SuperSignal™ West Pico Chemiluminescent Substrate 

34075 SuperSignal West Dura Extended Duration Substrate 

34095 SuperSignal West Femto Maximum Sensitivity Substrate 

46640 SuperSignal Western Blot Enhancer 

32209 Pierce™ ECL Western Blotting Substrate 

32132 Pierce ECL Plus Western Blotting Substrate 

24615 Imperial Protein Stain, 1L 

88518 PVDF Transfer Membrane, 0.45µm, 26.5cm × 3.75m 

88018 Nitrocellulose Membrane, 0.45µm, 30cm × 3.5m 

88610 Western Blotting Filter Paper, extra thick, 8.5cm × 9cm 

26616 PageRuler™ Prestained Protein Ladder, 10-170kDa, 2 × 250µL 

26619 PageRuler Plus Prestained Protein Ladder, 10-250kDa, 2 × 250µL 

26614 PageRuler Unstained Protein Ladder, 10-200kDa, 2 × 250µL 

26634 Spectra™ Multicolor Broad Range Protein Ladder, 10-260kDa, 2 × 250µL 

26625 Spectra Multicolor High Range Protein Ladder, 40-300kDa, 2 × 250µL 

26628 Spectra Multicolor Low Range Protein Ladder, 1.7-40kDa, 250µL 

26612 Pierce Prestained Protein Molecular Weight Marker 
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Glossary 

Aperture  Diameter of the lens opening that limits the 
amount of light entering the camera 

CCD  Charge coupled device that converts a photoelectric 
signal into electronic data 

CCD Camera  Camera with CCD sensor used to capture 
moving and still images 

Chemiluminescence (Chemi) mode  Captures image of 
sample-emitted luminescent as well as sample image 
under epi-white light 

Display Saturation  Displays red-painted image pixels if pixel 
intensity reaches a value near saturation 

Emission filter  Optical glass filter mounted in the Filter 
Wheel; used for filtering specific wavelengths of light 

Filter Wheel  Automated wheel that can hold multiple filters 
in front of camera lens 

Gallery  Holding space for captured images 

Hard (Main) Power Switch  Main power rocker switch 
located on the rear imager panel 

Lens  Optical device that controls light transmission 

Noise  Imperfections in the image data 

Plug-and-play  Ability of a computer system to automatically 
configure and operate other connected devices 

Remote Access  Imager access by technical support to a 
remote location 

Reset  Returns camera settings to the standard or home 
value 

 

Resolution  Sharpness and clarity of an image; defined by 
the number of camera pixels used to capture an image 

Sample screens  The clear, black and white panels  placed 
over the transilluminator during image acquisition 

Sensitivity  CCD camera’s degree of response to light 

Soft Power Switch  Blue-lit round button located on the front 
imager panel 

Stylus  Pen-shaped device used to input commands on the 
touchscreen 

Transilluminator  Sliding sample work platform containing 
the UV bulbs 

Ultraviolet (UV) mode  Captures images using transmitted 
ultraviolet light 

Visible (Vis) mode  Captures image using transmitted light 
and/or reflected visible light 
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